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1. Dulezité

Tato elektronicka uzivatelska prirucka je
urcena pro kazdého uzivatele tohoto monitoru
Philips. Pred pouzivanim monitoru si prectéte
tuto uzZivatelskou prirucku. Obsahuje dllezité
informace a pozndmky k pouzivani vaSeho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po priloZeni origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
nakupu, jméno prodejce a modelové a vyrobnf
Cislo vyrobku.

1.1 Bezpecnostni opatreni a udrzba

(D Varovani

Pouziti kontrol, Uprav nebo postupl jinym

zpUsobem nez je stanoveno v této dokumentaci

muze vést k ohrozeni Sokem, elektrickym a/

nebo mechanickym rizikdm.

Prectéte si a dodrzujte tyto instrukce pri

zapojovan( a pouzivani vaSeho PC monitoru.

Pouzivani

* Nevystavujte monitor primému slunecnimu
zarent, velmi silnym jasnym sveétldm a
udrzujte jej mimo dosah jinych zdrojd tepla.
Dlouhé vystaveni tomuto typu prostredf

mUze mit za nasledek zménu barev a
poskozeni monitoru.

*  Odstrarite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo
zabrdnit dostatecnému chlazenf elektroniky
monitoru.

* Nezakryvejte vétraci otvory ve skififice.

*  Umistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupna.

* Jestlize jste vypnuli monitor odpojenim
napdjeciho kabelu nebo kabelu napajeciho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normalné.

Vzdy pouzivejte napdjeci kabel schvaleny
spole¢nostfl Philips. Pokud napd jec( kabel
chybi, obratte se na nejblizsi servisni
stifedisko. (Viz informace o stfediscich
zdkaznické péce)

B&hem pouZivani nevystavujte monitor
nadmeérnym otresim nebo ndrazdm.

Pri pouZivdni nebo premistovdni do
monitoru nekopejte a zabrafite prfpadnému
padu.

Udrzba

Aby byl monitor chranén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmeérny tlak. Pf prremistovdni zvedejte
monitor za ram; pri zvedani monitoru
nesahejte rukou nebo prsty na panel LCD.

Nebudete-li monitor delSi dobu pouzivat,
odpojte jej ze zdsuvky.

Pred ocisténim mime navihcenym
hadrikem monitor odpojte ze zdsuvky.

Je-li vypnuté napdjent, Ize obrazovku otfit
suchym hadrikem. K ¢isténi monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napriklad alkohol nebo Cistice s obsahem
Cpavku.

Zabrarite nebezpedi Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pred prachem,
destém, vodou nebo nadmeéme vihkym
prostredim.

Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadikem.

Vnikne-li do monitoru cizi latka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizf ldtku nebo vodu

z monitoru a odeslete jej do servisniho
stediska.

Monitor neskladujte ani nepouzivejte
na mistech vystavenych teplu, pfimému
slunecnimu zareni nebo extrémnim
teplotam.

Chcete-li zachovat optimdln{ vykonnost
monitoru a prodlouzit jeho zivotnost,
pouzivejte jej na misté, které spliiuje
nasledujici rozsahy teplot a vlhkosti.



|, Dileito
+ Teplota: 0-40°C 32-95°F
e Vlhkost: 20-80% relativni vihkosti

Dulezité informace pro vypaleni obrazu/
zdvojeného dosvitu

* Pred ponechanim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky. Bude-li
na vasem monitoru zobrazen nemeénici
se staticky obsah, vzdy aktivujte aplikaci
pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni** obrazovky, rovnéz
znamé jako ,,dosvit” nebo ,,zobrazenf
duchd™.
,Vypaleni*, ,,dosvit" nebo ,,zobrazenf
duchtd' je dobre zndmy jev u technologie
paneld LCD. V mnoha pripadech ,,vypdleni”,
,dosvit" nebo ,,zobrazeni duchl* postupné
zmizi po urcité dobé mimo provoz.

) Vystraha

Selhanf aktivace sporice obrazovky nebo aplikace
pro pravidelné aktualizovani obrazovky mize mit
za nasledek vdzné priznaky ,vypaleni,, dosvitu"
nebo ,,zdvojeného dosvitu", které nezmizf a
nelze je opravit. Na vyse uvedené poskozenf se
nevztahuje zdruka..

Servis

*  Kryt plasté mUze oteviit pouze kvalifikovany
servisni pracovnik.

* Pokud je pro opravu vyzadovdna
dokumentace nebo integrace, obratte se
na nejblizsi servisni stredisko. (Viz kapitola
,Stredisko zdkaznické péce™)

* Informace o prevdzeni najdete v Cdsti
,, Technické udaje".

* Neponechavejte monitor v auté nebo v
zavazadlovém prostoru auta na primeém
slunci.

& Pozniamka

Pokud monitor nefunguje sprdavné nebo pokud
si nejste jisti, jaké kroky je tfeba provést po
provedeni pokynu v této prirucce, obrat'te se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisuji zplsob zépisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strdnkach této prirucky mizete narazit na
text, ktery je opatfeny symbolem a je vytistén
tucné nebo kurzivou. Takové useky obsahujf

poznamky, upozomeén( a vystrahy. Jejich pouziti

Je nasleduyict:

& Poznamka

Tento symbol oznacuje dulezité informace a
navrhy, které pomahaji lépe vyuzit pocitacovy
systém.

€@ Upozornéni

Tento symbol oznacuje informace, které
objasfuji, jak se vyhnout moznému poskozen(
zarizeni nebo ztraté dat.

) Vystraha

Tento symbol oznacuje nebezpec( télesneého
ublizenf a vysvétluje, jak se danému problému
vyhnout.

Neékteré vystrahy se mohou objevit v rizné
podobg a nemusi byt uvozeny symbolem.V
takovém pripade je konkrétni vyznacenf vystrahy
nafizeno uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zarizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Sestaveni monitoru 2 Namontujte stojanek podstavce
1. Umistéte monitor obrazovkou dold na

meékky a hladky podklad, aby nedoslo k
2.1 Instalace poskrdbani obrazovky.

2. Pripojte sloupek podstavce k monitoru tak,
El Obsah krabice aby zaklapl do pozice.

%i%art

seoco | PHILIPS

e

3. Uchopte monitor obéma rukama a
pripevnéte stojdnek podstavce do sloupku
podstavce.

VGA (nepovinny) DVI (nepovinny)



El Pripojeni k poéitadi

PHILIPS

(1) Vstup strfdavého napdjeni

@ \stup VGA

© Vstup DVI-D (k dispozici pro vybrané
modely)

@ Audio vstup (k dispozici pro vybrané
modely)

© Zimek proti krddeZi Kensington

Pripojeni k pocitaci

1. Pevné pripojte napdjeci kabel k zadnf strané
monitoru.

2. Vypnéte pocitac a odpojte jeho napdjeci
kabel.

3. Pripojte signdlovy kabel monitoru do video
konektoru na zadnf strané pocitace.

4. Zapojte napdjeci kabel pocitate a monitoru
do nejblizsi zasuvky.

5. Zapnéte pocitac a monitor. Jestlize se
na monitoru objevi obraz, instalace je
dokoncena.

2.2 Ovladani monitoru

1 Popis vyrobku z celniho pohledu

OOOOO‘J

E]
H
3
&

. ——
Model 226V4LA:
(5]
AUTO/ W 1 /A 0-/4 /0K 0)
© o o606 o o

Model 226VA4L:

(5]

AUTO/VY  [0/A 0/« /0K 0)

| L |
(7 6 0 6 o (1

Slouzi k ZAPNUTI a VYPNUTI
napajeni monitoru.

o O

Slouzi ke vstupu do nabidky

@ &/O0K/OsD.

Potvrzeni nastaveni OSD.

Slouz{ k ndvratu na prredchozf
o < Urovers OSD. "
(4 O-  |Nastaven( Urovné jasu.
© | A V¥V Slouii k dpravém nabidky OSD.
o SIoué( k 'Ljpravé nastaven(
0o hlasitosti reproduktoru.

lf  |Zmé&na formatu zobrazen.

©@ AUTO |Automatické nastaveni monitoru.




2. Sestaveni monito

H Popis zobrazeni funkci na obrazovce Nabidka OSD

. , NiZe je uveden celkovy pohled na strukturu
C bidk: b OoSsD)?
© je nabidka na obrazovee (OSD) OSD. Tento prehled miZete vyusft, budete-|i

Funkei nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny viechny monitory
LCD Philips. UmoZfiuje koncovému uZivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru prfmo prostrednictvim VGA
zobrazeného okna s pokyny. Nize je uveden — Input I:

Y v . f , DVI
priklad prijlemného rozhrani obrazovky:

(available for selective models)
Model 226V4LA:

Main menu Sub menu

— Picture Format —
— Picture

— Brightness —

— Contrast —

L— SmartContrast —_—

— Stand-Alone —
—— Audio

— Mute —

(available for selective models)

Color Temperature ——

— Horizontal —
—— OSD Settings

— Vertical —

— Transparency

— OSD Time Out -

I 10
1 50 L Setup — Auto

— H. Position

— V. Position

— Phase

— Clock

— Resolution Notification

I— Reset

Zikladni a jednoduché pokyny k ovladacim .
vy o L Information
tlacitkum

Ve vySe uvedené nabidce obrazovky OSD
muzete stisknutim tlacitek ¥ A na prednim
rdmecku monitoru pohybovat kurzorem a

stisknutim OK potvrdit vybér nebo zménu.

chtit pozd€ji prozkoumat rlznd nastavent.

Wide Screen, 4:3
0~100

0~100

On, Off

On, Off

On, Off

6500K, 9300K

— Color
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English, Espafiol, Francais, Deutsch, Italiano,

Portugués, Pycckuii, KA 3Z, Tirkge

0~100
0~100
Off, 1,2, 3,4

5s, 10s, 20s, 30s, 60s

— 0~100
— 0~100
— 0~100
— 0~100
— On, Off
— Yes, No



El Poznimka k rozliseni

Tento monitor je urcen pro optimalni vykon
pri nativnim rozliseni 1920 x 1080 pri 60 Hz.
Kdyz je monitor zapnut pri jiném rozliSeni, na
obrazovce se zobrazf vystraha: Pro optimaln{
vysledek pouZijte rozliseni 1920 x 1080 pri 60
Hz.

Zobrazovan( vystrahy na nativni rozliSeni Ize
vypnout v ¢asti Setup (Nastaveni) v nabidce
OSD.

4] Fyzické funkce
Naklon

2.3 Odpoijte stojanek podstavce a
podstavec

Bl Demonti? stojanku podstavce

Nez zacnete demontovat podstavec monitoru,
postupujte podle pokynd niZe, aby se zabranilo
Jakémukoli moznému poskozeni nebo zranen.
1. Umistéte monitor obrazovkou dold na

mekky podklad, aby nedoslo k poskrabanf
obrazovky.

2. Stisknéte zajistovaci svorky a oddélte
stojdnek podstavce od sloupku podstavce.

3. Pro odpojeni sloupku podstavce stisknéte
uvolfiovac tlacftko.




& Poznimka
Tento monitor je kompatibilni's T00mm x

100mm montdznim rozhranim kompatibilnim
se standardem VESA.




3. Optimalizace Obrazu

3.1 SmartContrast

B Cojeto?

Jedinena technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastni pomér monitoru LCD pro maximalni
vizudlnf Cistotu a pozitek ze sledovani. Zvysuje
podsviceni pro jasné€jsi, ostrejsi a jasnejsi obraz
nebo snizuje podsviceni pro jasné zobrazeni
obrazu s tmavym pozadim.

E3 Proc to potfebuiji?

Z4ddte nejvy&i vizudlnf &istotu a pohodlf
sledovdni jakéhokoli typu obsahu. SmartContrast
dynamicky ridi kontrast a upravuje podsvicen(
pro jasne, ostreé a jasné zobrazen( her a videa
nebo pro zobrazenf jasného, Citelného textu
pro kanceldfskou praci. Omezenim spotreby
monitoru Setrite ndklady a prodluzujete Zivot
vaSeho monitoru.

E} Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném case analyzovat zobrazeny obsah a
upravovat barvy a fidit intenzitu podsviceni. Tato
funkce bude dynamicky vylepSovat kontrast pro
skvely zdZitek pri prohlizeni fotografii nebo hranf
her.

3.2 Philips SmartControl Lite

Novy software SmartControl Lite od
spole¢nosti Phillips umoZfiuje ovladat monitor
prostrednictvim snadno pouzitelného grafického
rozhrani na obrazovce. SloZitd nastavenf jsou
minulostf, protoZe tento uZivatelsky prijemny
software vds provede jemnym vyladénim
rozliSeni, kalibraci barev, nastavenim frekvence/
faze, nastavenim bflého bodu RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows 7, ktery je vybaven nejnovejs
technologif v jadrovém algoritmu pro rychlé

zpracovani a odezvu, je pfipraven rozsifit vasi
zkuSenost s monitory Philips!

Instalace

Postupujte podle pokynl a dokoncete
instalaci.

MUzete spustit po dokoncenf instalace.
Chcete-li spustit pozdégji, mizete klepnout
na zdstupce na pracovni plose nebo na
panel ndstroju.

PHILIPS

www.philips.com/welcome

Monitor driver and software installation
Syscem requirements:
* PC running Windeaws 7, Vista, XF, 2000, 98

b Go to www.philps.comiwelcome 1o downlaad the latest version of moritor driver

Philips SmartCantral
System support and requirements:
1. System support Windows 7, Vista, XP.

2 Language support English, German, Spanish, French, Italian, Russian, Portuguese, Simplified Chinese
3. Philips Monicor Plug and Play suppot

Prvni spusténi —Wizard (Privodce)

Pri prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Prévodce).

Tento privodce vds provede podrobnym
nastavenim vykonu monitoru.

Privodce muzete rovnéz spustit pozdeji z
nabidky Plug-in (Zasuvny modul).

Dalsi moZnosti mUzete nastavit bez
pravodce prostrednictvim podokna
Standard (Standardni).



3. Optimalizace Obrazu

1B SmartControl 2 - Philips 225B1 (€530715000001) | 2)(X)

SmartControl Lite PHILIPS

Wizard

You'l need to calibrate your display to get the most
accurate color. We encourage you to use the simple
tuning process by selecting the Start Wizard button.
This process invalves a series of steps that willlet you
tune your display and save the settings.

1. Choose the Start Wizard button.

2. Follow the steps outined in this process.

3. save your settings for future use.

]

Adjust Audio

\g Auto Pivot
T
Color Tnput
)
2
Options Presets

Multi Monitors

&

Help

Start Wizard

E3 Spusténi s podoknem Standard
(Standardni):

Nabidka Adjust (Nastaveni):

* Nabidka Adjust (Nastaveni) umoziiuje
upravit Brightness (Jas), Contrast (Kontrast),
Focus (Ohnisko), Position (Poloha) a
Resolution (Rozlisen).

* MduZete postupovat podle pokynd a provest
nastaven.

» Cancel (Storno) vyziva uZivatele, chcete-li
ukondit instalaci.

B smartControl 2 - Phiips 22581 (CS30715000001) | 7)(X)

SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wil resuft in a loss of
detailin darker image areas. Adjust the Brightness for
the best possible picture guality.
1. Lower the Brightness to the minimum level.
2. Raise the Brightness to the desired level.
3. Adjust the Brightness as needed to achieve
an equal separation of the stripes.

Focus Brightnass

s

Undo Reset.

Resolution

Help

10

B SmartControl

SmartControl Lite

Adiust )

Brightness

Contrast

Color
A

= Focus

Position

v

Resolution

B smartcontrol

SmartControl Lite

Adjust Q
Brightness
Contrast
Color
- Focus
s 8
Position
Options ?F

Resolution

Help

B SmartControl

SmartControl Lite

Adjust )

Brightness

o

Contrast

Resolution

2 - philps 22581 (CS30715000001) %)X

PHILIPS

Contrast

Adjust the Contrast (use the siider) to keep details in
lighter image areas.
1. Raise the Contrast until the numbers 1 and 2
are no longer visible,
2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visble.

Contrast 50

[+

Undo Reset

2 - Philips 22581 (CS30715000001) § ¥} %)

PHILIPS

Focus

Your display's timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are stil visble, you'l need

to adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting ta minimize
movement on the screen.

Pitch 50

S © &

Phase 17

o < &
Undo Auto Setup

2 - Philps 22581 (€S30715000001) (71X

PHILIPS

Position

Use the Position buttons to center the image on
your display. Using this tool, you can position the image
up, down, left, or right.
1. Use the Up/Down buttons to center the image
verticaly.

2. Use the Left/Right buttons to center the image
horizontaly.
Undo Reset




3. Optimalizace Obrazu

-
B smartControl

SmartControl Lite

Adjust Q

Brightness

o

Contrast

Color %

Focus

Position

Options ﬁ
Resolution

Help

(&

Nabidka Color (Barva):

2 - philps 22581 (csa0715000001) {Z)\%)
PHILIPS

Resolution

You are curently at a Preferred resolution. For your
display to show crisp, clear text, colors, and images,
your display should be set to its Preferred resolution.
If your display is 3t 2 Non-Preferred resolution, click
on the Preferred button to change your resolution to
Preferred.

™ Enable Resolution Notfier

Picture Format
™ 4:3 aspect ratio

Preferred

* Nabidka Color (Barva) umozriuje upravit
RGB, Black Level (Urovef ¢erné), White

Point (Bily bod), Color Calibration (Kalibrace

barev).

*  MduZete postupovat podle pokynd a proveést

nastaven.

* V ndsledujici tabulce vyhledejte polozku
podnabidky na zdkladé vaseho vstupu.
* Priklad pro Color Calibration (Kalibrace

barev)
@ smartcontrol

SmartControl Lite

White Point

Display Gamma

-

Calibration

2 - Philips 22581 (CS30715000001) {F](%) |

(L]

PHILIPS

Black Level

Improperty adjusted Black Level will result in 2 loss of
detai in darker image areas. Adjust the Black Level for
the best possible picture quality.
1. Adjust the black level of the Red, Green, and
Blue using the slider bars.

Red 50

= o @

Green 50

= o =

Blue 50

o o b
Undo Reset

* |8 smartControl

SmartControl Lite

"

RGB

BIac!« Level

whle Point
Display Gamma
wyl

Options Calibration

Help

B SrwtContiol

SmartControl Lite

L)

Adijust RER
Black Leve!
o

Cokor White Pont
S g
| Dsplay Gamme
LY
Options Gibiatin
oo

B SmantControl

SmartControl Lite

L

Adjust RGE

y Dh!'l!e\lel
e

Cokor white Pont

Display Garrera

L

2 - philips 22581 (Cs30715000001) {F](X) )

PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and biue light at full intensity create
white. This effects the overall color quality. For the
most accurate colors click the Reset button then
select the White Paint.
1. Please select the White Point value for the best
possible color quality.

White Point 6500K
= Y e

Undo Reset

2 - Philps 22581 (C530715000001) 1 X

PHILIPS

Display Gamma

G
dufault vale for Gamra &

To adjust Garrer, Serurt Ty
Cick the St Trage Off butt

Garmma

§. Use the sider to select the desred Gamma.

Display Gamma 22
= - &
Smartimage OFF
Unida Reset

2 - Philps 22581 (C530715000001) (3] 5-
PHILIPS

Calibration

Your deplay neads to be propery calibrated n order
for & to produce the widest range of colors accurately.
Calibration should abways take place as the bst tuning
step In the process. Remember to recalbrate any tme
you make ndwidual adjustments to mage qualty or
whenever you move your display to 2 new lacation.
1. Mzke al other necessary adjustments to image
qualty first.
2. Press Show Me to leam how to use the
calibration took.
3. Finally, press Start to begn the calibration
process.

¥ Enable color calbration

ke software designie in cokabaration with Jaseph
Halmes.

Pratected by U.S. Patent No. 6,686,953

Show Me Start.

Quick View



3. Optimalizace Obrazu

1.

2.

Tlacitko ,,Show Me" (Predvést) spusti
vyukovy program pro kalibraci barev.

Start (Spustit) — zahdji sekvenci kalibrace
barev o 6. krocich.

QuickView (Rychlé zobrazeni) nacte
zobrazen( pred/po.

Chcete-li se vrétit na hlavni strdnku Color
(Barva), klepnéte na tlacftko Cancel
(Storno).

Enable color calibration (Povolit kalibraci
barev) — ve vychozi konfiguraci je zapnuto.
Pokud tato poloZka nenf zaSkrtnuta, kalibraci
barev nelze proveést a tlacitka rychlé
zobrazeni nejsou k dispozici.

Na kalibra¢ni obrazovce musi byt zobrazeny
informace o patentech.

Calibration Screen (Obrazovka kalibrace)
prvni barvy:

Tlacitko Previous (Predchozi) je
deaktivovdno aZ na obrazovku druhé barvy.
Tlacitko Next (Dalsf) slouzi k prechodu na
nasledujici cil (6 cfld).

Tlacitko Konecny slouzi k prechodu na File
> Presets (Soubor > podokno Predvolby).
Tlacitko Cancel (Storno) slouzi k ukoncenf
uzivatelského rozhrani a k ndvratu na
stranku zasuvnych moduld plug-in.

Options>Preferences (Moznosti>Predvolby) —
Tato moznost bude aktivni pouze po vybéru
polozky Preferences (Predvolby) v rozeviracf
nabidce Options (MoZnosti). Na nepodporova-
ném zobrazovacim zarizen( s podporou DDC/
Cl jsou k dispozici pouze karty Help (Ndpoveda)
a Options (MoZnosti).
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8 smartControl

L
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SmartControl Lite PHILIPS

Preferences

You can use the folowing options to configure

SmartControl.

¥ Enable menu when right-clicking on desktop

¥ Enable task tray menu

¥ Run at system start-up

Set Transparency:
& 0% © 50% C 100%

= 2
-

Adijust Audi

-

Auto Pivet

-
Color nput

b

Wizard

2
Presets

- o

Multi Monitors

Help

Zobrazi nastaven( aktudinich predvoleb.
Zaskrtnuté tlacftko aktivuje funkci.
Zaskrtavaci policko je prepinac.

PoloZka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychoz{ konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context

Menu (Povolit mistni nabidku) se zobrazf
vybéry SmartControl Premium pro funkce
Select Preset (Vybrat predvolbu) a Tune
Display (Ladénf zobrazeni) na pracovni
plose klepnutim pravym tlacitkem mysi na
mistni nabidku. Volbou moZznosti Disabled
(Deaktivovdno) bude polozka SmartControl
Premium odstranéna z mistni nabidky
pravym tlacitkem mysi.

PoloZka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistni nabidku se zobrazf nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem mysi na ikonu
na hlavnim panelu se zobrazi moznosti
nabidky Help (Ndpoveéda), Technical
Support (Odbornd pomoc), Check for
Update (Vyhledat aktualizace), About

(O aplikaci) a Exit (Konec). Kdyz je
deaktivovdna polozka Enable task tray menu
(Povolit nabidku na hlavnim panelu), ikona
na hlavnim panelu zobrazuje pouze moznost

EXIT (KONEC).



3. Optimalizace Obrazu

* PoloZka Run at Startup (Spustit pri startu) je
ve vychozi konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato poloZka deaktivovana, funkce
SmartControl Lite se nespusti prfi startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
ploSe nebo prostrednictvim souboru
programu. Kdyz toto policko nenf zaSkrtnuté
(Deaktivovdno), zadna predvolba nastavend
pro spusténi pri startu nebude nactena.

* Enable transparency mode (Aktivovat rezim
prihlednosti) (Windows 7, Vista, XP).
Vychoz( nastaven( je O % neprihlednost.

Options>Input (Moznosti>Vstup) — Tato
moZnost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (MoZnosti). Na nepodporovaném
zobrazovacim zarizen( s podporou DDC/CI
jsou k dispozici pouze karty Help (Napovéda)
a Options (MoZnosti). Zadné dal¥f karty funkce
SmartControl Lite nejsou k dispozici.

2 - Philps 22581 (CS30715000001) ]\ X,

PHILIPS

" I SmartControl
SmartControl Lite

Input

Your display has two inputs (connections on back of
this disply) so you can haok up two different sources
at the same time. Use the Analog In and Digital In
buttons to select which source you'd like to view. You
are currently viewing the analog in image.

IMPORTANT! If you switch inputs SmartControl may
lose the ability to control your monitor. In this case you
may have to use the Input Select button on the front
of your monitor to switch back to the original input
before SmartControl functionality can be restored.

§

Adijust Audio

\U Auto Pivot
Color Input
.
\Q Wizard
: 2
Options Prasets
\Q Muli Monitors
Help

Analog In Digital In

* /obrazi podokno s pokyny Source (Zdroj)
a nastaven( aktualntho zdroje vstupu.

* U zobrazovacich zafizeni s jednim vstupem
nenf toto podokno zobrazeno.
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Options>Audio (Moznosti>Zvuk) — Tato
moZznost bude aktivni pouze po vybéru polozky
Audio (Hlasitost) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zar{zen( s
podporou DDC/CI jsou k dispozici pouze karty
Help (Napovéda) a Options (MoZnosti).

2 - Phiips 22581 (€530715000001) | 2)(X)

PHILIPS

B smartControl

SmartControl Lite

Audio

Adjust the Volume of the integrated loudspeakers by
using the slider.

Turn off the integrated loudspeakers by checking the
Mute checkbox.

Audio

Adjust
@ Auto Pivot
T
Color Input
> tey k
‘ 2
Options Presets
Multi Monitors
Volume 100
Help = Q@

Undo

Help>User Manual (Napovéda>Uzivatelska
prirucka) — Tato moznost bude aktivni pouze
po vybéru polozky User Manual (UZivatelska
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zar{zen( s
podporou DDC/CI jsou k dispozici pouze karty
Help (Napovéda) a Options (MoZnosti).

2 - Phips 22581 (C530715000001) |2)X)

PHILIPS

B SmartControl
SmartControl Lite

User Manual

If you need help setting up or operating SmartControl,
click the Tech. Support button. You'l have the
aption to fil out an Assistance Form.

You can also choose to have information about your
software automaticall attached to the assistance
form. You'll need to be enline to use this feature.

N

Adjust

Usgnua\

g P
= °
Update
Color
]
m Disply ID
= =N
8 System ID
Options
X¥

Version

&

User Manual Tech. Support




3. Optimalizace Obrazu

Help>Version (Napovéda>Verze) — Tato
moznost bude aktivni pouze po vybéru

polozky Version (Verze) v rozeviraci nabidce
Help (Napoveéda). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (MoZnosti).

B smartControl 2 - philips 22581 (CS30715000001) (2i X

SmartControl Lite PHILIPS

Version

SrartContral

Version 0.00 EVALUATION dtune-plp-R2009-12-17-
1913-04

DDC/CI Communication: Yes - ATI2 API

i

Copyright @ 1993-2009 Portrait Displays, Inc.
Adjust

User Manual

P
e

Update

ﬁ

Color

B

Display ID

2]

System ID

XX

Version

)

Options

Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je
ve vychozl konfiguraci Aktivovdna. Nabidka
bude zobrazena po zaSkrtnutf polozky Enable
Context Menu (Povolit mistnf nabidku) v &3sti
Options > podokno Preferences (Moznosti >

podokno Predvolby).

ﬁ SmartControl
Select Preset 4
Tune Display

Context Menu (Mistni nabidka) obsahuje 3

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

* Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku uloZenych predvoleb
pro okamzité pouziti. Aktualné vybrana
predvolba je oznacena zaskrtnutim. V
rozeviraci nabidce Ize rovnéZ vybrat polozku
Predvolby vyrobce.
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* Tune Display (Ladénf zobrazeni) — otevi'e
ovlddaci panel SmartControl Lite.

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu Ize zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacitkem Ize spustit aplikaci.

Help

Technical Support
Check for Update
About

Exik

Hlavni panel obsahuje pét polozek:

* Help (Napoveéda) — pristup k souboru
s User Manual (uZivatelskou priruckou):
Otevre soubor s User Manual (uZivatelskou
priruckou) v okné vychoziho prohlizece.

* Technical Support (Odborna pomoc) —
zobraz( strdnku odborné pomoci.

*  Check for Update (Vyhledat aktualizace) —
zobrazi Uvodnf stranku PDI a porovna verzi
uZivatele s nejaktudlnéjsi dostupnou verzi.

* About (O aplikaci) — zobrazi podrobné
referenni informace: verze produktu,
informace o vyddani a ndzev produktu.

* Exit (Konec) - ukon¢i SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose
pocitace nebo restartujte pocitac.

PHILIPS

SmartControl

SmartControl
Version 3.20
cune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Portrait Displays, Inc.
Patents Pending




3. Optimalizace Obrazu

Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovan ve slozce
Preference (Predvolby), je k dispozici pouze
cast EXIT (KONEC). Chcete-li funkci
SmartControl Lite zcela odstranit z hlavniho
panelu, deaktivujte polozku Run at Startup
(Spustit pri startu) v casti Options>Preferences
(Moznosti>Predvolby).

& Pozndmka

Veskere ilustrace v této Casti jsou pouze
orientacni.Verze softwaru SmartControl se
muze zménit bez predchoziho upozornént.
Vzdy navstivte oficidlni webové stranky Portrait
na adrese www.portrait.com/dtune/phl/enu/
index a stdhnéte si nejnovéjsi verzi softwaru
SmartControl.
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4. Technické udaje

Obraz/disple

Typ panelu LCD TFT-LCD

Podsviceni LED

Velikost panelu 215" S (54,6 cm)
Pomér stran 16:9

Roztec obrazovych bodu 0,248 x 0,248 mm

Jas 250 cd/m? or 200 cd/m?
SmartContrast 10.000.000:1

Kontrastni pomér (typ.)

1000:1 or 600:1 for 200 nitd or 3000:1 for MVA panel

Doba odezvy (typickd)

5ms or 25ms for MVA panel

Optimalni rozlisenf

1920 x 1080 pri 60 Hz

Zorny Uhel

170° (H) / 160° (V) pri C/R>10
or 90° (H) / 65° (V) pri C/R>10 for 200 nitl
or178° (H) / 178° (V) @ C/R>10 for MVA panel

Barevnost displeje

16,/M

Vertikdlni obnovovaci frekvence | 56Hz - 76Hz
Horizontalni frekvence 30kHz - 83kHz
sRGB ANO

Vstup signalu

DVI-D (digitdIni) (nepovinny), VGA (analogovy)

Vstupni signal

Usnadnéni pro uzivatele

Oddélend synchronizace, synchronizace podle zelené

226VALA:  auTo/w (/A 0/ 4 /0K O]
226V4L: auTO/Y  EN/A 0/ 4 /0K O]

Jazyky nabidky OSD

anglictina, francouzstina, némcina, italstina, rustina, Spanélstina,
zjednodusend ¢instina, portugalstina, turectina

Dalsi usnadnéni

Zamek Kensington

Kompatibilita s technologif
Plug & Play

DDC/CI, sRGB, Windows 7/Windows 8/Vista/XP, Mac OSX,
Linux

Podstavec
Naklon -5/+20
226VA4LA:
Zapnuto 21,45W (typ.), 25,65W (max.)
Spanek (Pohotovost) 0,5W
Vypnuto 0,5W
Indikdtor napdjen( Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)
Napdjenf Vypaleni, 100-240VAC, 50-60Hz
226VA4L:
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21,5W (typ.), 23W (max.)

Zapnuto or 20,5W (typ.), 23,71W (max.)200 nitd

or 23,6W (typ.),27,82 W (max.) for MVA panel
Spanek (Pohotovost) 0,5W
Vypnuto 0,5W

Indikdtor napdjenf

Zapnuto: Bila, Pohotovostni rezim/rezim spanku: Bild (blikd)

Napdjeni

Vypdleni, 100-240VAC, 50-60Hz

Vyrobek s podstavce (SxVxH) 514 x 388 x 213 mm

Vyrobek bez podstavce (SxVxH)

514 x 320 x 48 mm

Vyrobek s podstavcem 3,34kg
Vyrobek bez podstavce 3,00kg
Vyrobek s obalem 4,5%g

Teplotni rozsah (provoz)

0°C az 40 °C

Shoda a normy
Prohldseni o shode

Oplaste
Barva

Teplotni rozsah (mimo provoz) -20°C az 60°C

Relativni vihkost 20% az 80%

MTBF 30 000 hod

ROHS ANO

EPEAT Silver (www.epeat.net)
Balenf 100% recyklovatelny
Specifické Vldtky Kryt 100% bez PVC BFR
Energy Star ANO

CE Mark, FCC Class B, GOST, SEMKO, TCO certified (Only for
selective models), UL/cUL, 1ISO9241-307,BSMI

Cernd nebo Bil4

Povrchovd Uprava

Leska/Textura

& Poznamka

1. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spole¢nost Philips zaregistruje produkt.
Informace o stavu registrace ve vasi zemi viz www.epeat.net.

N

www.philips.com/support.

Y%

Tyto Udaje se mohou zmeénit bez predchoziho ozndment. Stahnéte si nejnovejsi verzi letdku z webu



4.1 Rezimy rozliseni a predvoleb

El Maximélni rozliseni
1920 x 1080 pri 60 Hz (analogovy vstup)
1920 x 1080 pri 60 Hz (digitalni vstup)

E3 Doporuéené rozliseni
1920 x 1080 pri 60 Hz (digitdlni vstup)

Vodorovna Rozliseni Svisla
frekvence frekvence
(kHz) (Hz)
31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
5594 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00
& Poznamka

Upozorfiujeme vas, Ze tento monitor funguje
nejlépe pri nativnim rozlisenf 1920 x 1080 pri
60 Hz. Pro dosazeni optimdini kvality zobrazenf
dodrzujte toto doporucené rozlisen.
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5. Rizeni spotfeby

Pokud je v daném pocitaci nainstalovan software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdZe automaticky
snizit svou spotrebu energie, neni-li pouzivan.
Pokud pocitac rozpozna vstup z klavesnice,

mysi nebo jiného vstupniho zafizeni, monitor se
automaticky ,,probudi*’. Ndsledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

226VA4LA:
Definice rizenf spotreby
Rezim VESA| Video | H-synch. | V-synch. [ Spotreba energie | Barva indikdtoru LED
Aktivni | ZAP. | Ano | Ano [ 2145W (typ) Bil4
Spének VYP. Ne Ne 0.5W (typ.) Bild (blikd)
Vypnuto | VYP. - - 0,5W (typ.) VYP.
226VA4L:

Definice r{zenf spotreby

Rezim VESA| Video | H-synch. | V-synch. | Spotieba energie | Barva indikdtoru LED

21.5W (typ.)
or 20,5W (typ.)

for 200 nitd
Aktivni ZAP. Ano Ano Bila

or 23,6 W (typ.)

for MVA panel
Spének VYP. Ne Ne 0,5W (typ.) Bild (blikd)
Vypnuto | VYP. - - 0,5W (typ.) VYP.

Ndsledujicl konfigurace se pouzivd pri méreni
energetické spotreby tohoto monitoru.

*  Nativni rozliseni: 1920 x 1080

* Kontrast: 50%

e Jas: 250 nitd or 200 nitd

Barevnd teplota: 6500 K's plné bilym
vzorkem

& Poznimka
Tyto Udaje se mohou zmeénit bez predchoziho

oznameni.
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6. Informace o regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery

& and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is TCO Certified - for Sustainable
T

TCO Certified is an intemational
third party sustainability certification

for IT products. TCO Certified.
ensures that the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited

iIndependent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

* Corporate Social Responsibility
Socially responsible production - working
conditions and labor law in manufacturing
country

* Energy Efficiency
Energy efficiency of product and power
supply. Energy Star compliant, where
applicable

*  Environmental Management System
Manufacturer must be certified according
to either ISO 14001 or EMAS

*  Minimization of Hazardous Substances
Limits on cadmium, mercury, lead
& hexavalent chromium including
requirements for mercury-free products,
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halogenated substances and hazardous
flame retardants

* Design for Recycling
Coding of plastics for easy recycling. Limit
on the number of different plastics used.

* Product Lifetime, Product Take Back
Minimum one-year product warranty.
Minimum three-year availability of spare
parts. Product takeback

» Packaging
Limits on hazardous substances in product
packaging. Packaging prepared for recycling

* Ergonomic, User-centered design
Visual ergonomics in products with a
display. Adjustability for user comfort
(displays, headsets) Acoustic performance
— protection against sound spikes
(headsets) and fan noise (projectors,
computers) Ergonomically designed
keyboard (notebooks)

* Electrical Safety, minimal electro-magnetic
Emissions Third Party Testing
All certified product models have been
tested in an independent, accredited
laboratory.

A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of all TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an intemational
driver in the field of Sustainable IT for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around the
world rely on TCO Certified as a tool to help
them reach their sustainable IT goals. We are
owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For more information, please visit
www.tcodevelopment.com



Tm

Technology for you and the planet
CERTIFIED

(Only for selective models)

EPEAT

(Www.epeat.net)

&

The EPEAT (Electronic
Product Environmental

%’ Assessment Tool) program
evaluates computer

desktops, laptops, and monitors based on

51 environmental criteria developed through

an extensive stakeholder consensus process

supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

*  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

*  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

*  2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

»  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following
standards

* 1509241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

* (S EK1-2000:2011 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

s MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

* TCO CERTIFED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish

Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turming the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de 'article
15 Des régles de la FCC. Ces limites sont
concues de fagcon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Informace o regulaci

Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

This devica belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it is a Class A device on the specification labal. The following applies to
devices in Clags A of EN 55022 (radivs of protection up to 30 meters). The ussr of the
device is obliged to take all staps necessary to remove sources of intarfarance o tala-
communication or athar devices.

Pokud nani na typowam &tithu poditade uvedenao, #2 spada do do ffidy A podis EN 55022,
spadd automaticky do tidy B podie EN 55022, Pro zafizen! zatazend do tFidy A (chranné
pésrmo 30m) podie EN 55022 platl nésledulicd. Dojde-l k rullenl telekormunikatnich nebo
Fnfich zafizeni je ufivatel povinnen prowdst takovd opatfgnl, aby rueni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

Urradzetde powinng byé wasilane 2 paiaeds ¢ preybaceanym obwodim ochronmym (iiaedo
kotkien). W\p\\llpmcnjam. i 5oy uregdeenia (kempuser, monstor, drukarkal powinny by zsilane
# i sk drddla.

Instalacja elektrycma pomieszceenta powine mwiesad w preewadsie Browym reeeraows achrong
proec] swarciami, w postaci bezprecenika o warkedcl mamionowe] me wigkszej nit 16A {amperew ).
W ocelu catkewitego wylycrenia ureadeenta 2 siee zasilania, nalesy wyjal wivezske kabla
sasilaigeepo 7 gmazdka, kidre powlmmo ziajdowad ss w pablia ureadeenda 1 byd 2atwo dostgpie

Znak berpicezefsiwa "B" potwiendea spodnost uresdrenia 2 wymaganiami beepiecefiuiwa
ukytkowanda yawartvitl w FR-UAT-H2107 1 PN-REAM2S].

Pozostale instrukcje bezpieczensiwa

* e maledy whvwad wiyezek sdaprerowwch Tub wuwad kedka obwedu achrormega 2 wiyeeki.

Tzl komseczne jest whyewe prasdbutacea to naledy whyé preediuiacea 3-vlowego 2

prawidbawa polsceonymm preewodem ochmannym.

System kompulerowy naleky sabespieceyd preed naphyme, chwilowymi werostami lub spad-

kami mapsgcia, wivwijac climnabors proepeed, ureasdremia dnpam'nujqn.n.gu lush

bermakiaceniowegn frodia zasilania

* Maledy |||:uvm|t sl &by nei i lekaloong kablsch systernu Lu||'||mll.1u\.u.g1‘r araz aby kable me
byly umieseceone w mu.l:u.l gdzie medna byloby na nie nadepiywad lub porykst sig o me.

* e maledy roelewad napopda and mych plyndo e systim Ko puenosy.

Mie nalery wpychal Fadnych preedmiotiny do abwondw systenmm komputervweygo, gdvi mode

ta spowodowad pedar lub poradenie prydem, popreee swarcie chemenida wewngtrznych

* Sy komputerowy powinden napdowad sig 2 dala od greejaikiw o irddel clepla. Porsdeo,
mie maleey blakawad atweraw wentylacyimych. Nabeiy unikac kladeensa luinych papserdw posd
kamputer orazx umiesrczansa kampubera w casnym migjscu bex mazhiwasa cyrkalaci pewi-
elrra wokal nisge.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

STOMTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELHENERIITE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Geréates befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
Il 5 Abs. 4 der Rontgenverordnung erfullt
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefuhrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt /0dB (A) oder
weniger.

M ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



6. Informace o regulaci
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label
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The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year.

&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi doddvat vyrobky
nejvyssi kvality. Pouziva nékolik nejpokrodilejsich
vyrobnich postupu vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektdm
obrazovych bodut nebo dil¢ich obrazovych
bodd u paneld TFT LCD, které se pouZzivaji

pro ploché monitory, se nicméné nékdy neda
zabrénit. Zadny vyrobce nemdze zarudit, ¥e
viechny panely budou bez defektl obrazovych
bodd, ale spole¢nost Philips zarucuje, Ze kazdy
monitor s nepfijatelnym poctem defektd bude
v rdmci zaruky opraven nebo vyménén. Tento
text vysvétluje jednotlivé druhy defektd na
pixelech a urcuje Unosnou Uroveri chybovosti
pro kazdy druh. Aby bylo moZzné uplatnit zarucnf
opravu nebo vymeénu, musi pocet defektnich
obrazovych bodd panelu TFT LCD presdhnout
tuto droven Unosnosti. Na monitoru napriklad
nesmi byt vice defektnich dil¢ich obrazovych
bodd nez 0,0004 %. Déle, protoze nékteré typy
kombinacf vad pixell jsou Iépe postrehnutelné
nez jing, stanovuje pro né spolecnost Philips
jeste vetsi naroky na kvalitu. Tato norma se
dodrzuje celosvétove.

4 N

subpixely subpixely subpixely

vy
pixelly
N /

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se skladd ze trf
subpixeld v zakladnich barvdch Cervené, zelené a
modré. Kdyz je mnoho pixeld pohromadé, tvor{
obraz. Kdyz vSechny subpixely urcitého pixelu
svitl, jevi se tyto tri subpixely spole¢né jako
jediny bily pixel. Kdyz jsou vSechny tmavé, jevi

se tyto tf1 subpixely jako jeden Cerny pixel. Dalsi
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely riznych barev.

Druhy pixelovych vad

Vady pixeld a subpixell se na obrazovce
projevuji riznymi zpUsoby. Existuji dva druhy
vad pixelu a v ramci téchto druht je ne€kolik
typU subpixelovych vad.

Defekty svétlych bodi

Defekty svétlych bodu se projevuji jako
obrazové body nebo dil¢i obrazoveé body, které
vzdy sviti nebo jsou 'aktivni®. Svétly bod je dil¢f
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmava plocha. Existuji

nasledujici typy defektd svétlych bodu:

4 N

o v

Jeden cerveny, zeleny nebo modry subpixel

4 N

| ¢

Dva soundlezici subpixely:
- Cerveny + modry = fialovy
- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry

o v

TH soundlezici rozsvicené subpixely (jeden bily
pixel).



& Poznamka Vzdaélenost pixelovych vad

Protoze vady pixeld a subpixeld stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrngsi, urcuje spolecnost Philips i tolerance na

Cerveny nebo modry svétly bod musi byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasné&jsi, nez

sousedn( body. vzdalenost vad pixelC.

Defekty tmavych bodi ( - ~ )

Defekty tmavych bodU se projevujf jako
obrazoveé body nebo dil¢i obrazoveé body, které
nikdy nesviti nebo jsou ,,neaktivni*. Tmavy bod je

dil¢i obrazovy bod, ktery vystupuje z obrazovky, .
kdyZ je na monitoru zobrazena svétld plocha.
- J

. /

Existuji ndsledujici typy defektd tmavych bodu:

4 N

e ™ Tolerance vad pixelQ
I Aby bylo mozZné uplatnit opravu nebo vymeénu
kvali defektnim obrazovym bodidm v zaru¢nf
dobé&, musi panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bodU
nebo dil¢ich obrazovych bodd, které prekracujf
\_ % tolerance uvedené v nasledujicich tabulkach.

KAZY JASNYCH BODU PRIATELNY POCET VAD

1 trvale sviticl bod 3

2 sousedn( trvale svitici body 1

3 sousednf trvale svitici body (nebo 1 trvale sviticl bily bod) 0

Vzddlenost mezi dvéma kazy jasnych bodd* >15 mm

Celkovy pocet kazl jasnych bodud viech typul 3

1 tmavy bod 5 nebo méné

2 sousedni tmavé body 2 nebo méné

3 sousedni tmavé body 0

Vzdalenost mezi dv€ma kazy cernych bodi* >15 mm

Celkovy pocet kazd ¢ernych bodd viech typu 5 nebo méné

KAZy bodi celkem PRIJJATELNY POCET VAD

Celkovy pocet kazl jasnych nebo cemych bodU vSech typu 5 nebo méné
& Poznamka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod
2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( 1SO 9241-307: Ergonimicky
pozadavek, analyza a metody testovani shody pro elektronickd zobrazovaci zafizeni)

3. Norma 1509241-307 je ndslednikem drivgjsi normy 1SO13406, kterd byla zrusena organizaci ISO
(International Organisation for Standardisation) ke dni: 2008-11-13

27



7.2 Péce o zakazniky & zaruka

Podrobné informace o zdruce a poZadavku na dodate¢nou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovné€Zz mizZete kontaktovat mistni centrum péce o zdkazniky na nize

uvedenych telefonnich cislech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena
Germany Siemens I&S +49 01803 386 853 € 0,09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call taniff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNi A VYCHODNI EVROPY:
Telefonni stredisko ASC

Cislo zakaznické péce

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
E%:Itae f‘egm NA Kim Tec d.o.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
NA Comel +380 562320045
Jaine NA gfjéieymce +38 044 245 73 31
S NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Telefonni stredisko

Cislo zakaznické péce

Brazil

Argentina

Vermont

0800-7254101

0800 3330 856

Kontaktni informace pro Cinu:

Cina

Cislo zékaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

Telefonni stredisko

ASC

Cislo zakaznické péce

USA.

EPl-e-center

Qwantech

(877) 835-1838

Canada

Supercom

Supercom

(800) 479-6696
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Kontaktni informace pro oblast APMEA:

Telefonni
stredisko

Cislo zakaznické péce

Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
. Hong Kong:Tel: +852 2619 9639
Hong Kong / Macau | NA Smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56677
Indonesi NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
onese Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA f;;'s Computer System Co. | 09y 934.5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
Umlted Arab NA AL SHAHD COMPUTER 00971 4 2276575
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA Cormpany Ltd +84 5113.562666 Danang City
pany =t +84 5113.562666 Can tho Province
T . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!str|butor and/or service
provider currently
Baneladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-42722395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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8. Odstranovani problému a
casté dotazy

8.1 Odstranovani problému

Na této strance jsou uvedeny problémy,
které mize odstranit uzivatel. Pokud problém
pretrvavd | po vyzkousen( té€chto resent,
kontaktujte zastupce sluzeb pro zakazniky
spolec¢nosti Philips.

Bl Bé&iné problémy

Zadny obraz (indikator LED napajeni nesviti)

* Zkontrolujte, zda je napdjeci kabel pripojen
k elektrické zdsuvce a do zadnf Casti
monitoru.

* Nejdrive zkontrolujte, zda se vypinac na
predni stran€ monitoru nachdzi ve OFF
(VYPNUTE) poloze a stisknéte jej do ON
(ZAPNUTE) polohy.

Zadny obraz (indikitor LED napéjeni je bily)

» Zkontrolujte, zda je zapnuty pocitac.

» Zkontrolujte, zda je kabel signdlu radné
pripojen k pocitadi.

»  Zkontrolujte, zda nejsou ohnuté koliky na
pripojovaci strané kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

* Pravdépodobné je aktivovdna funkce fizeni
spotreby

Obrazovka rika

Attention

Check cable connection

» Zkontrolujte, zda je kabel monitoru rddné
pripojen k pocitaci. (Rovnéz viz Stru¢nd
prirucka).

»  Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

» Zkontrolujte, zda je zapnuty pocitac.

Tlacitko AUTO nefunguje
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Automatickd funkce je pouzitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
neni uspokojivy, mizZete provést rucni
Upravy prostrednictvim nabidky OSD.

& Poznimka
Automatickd funkce nenf pouzitelnd v
rezimu DVI-digitdIni, protoze je zbytecna.

Viditelné znamky koure nebo jiskrreni

* Neprovddgjte Zddné kroky pro odstrafiovani
problému

*  Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napdjenf

* |hned kontaktujte zastupce sluzeb pro
zdkazniky spolecnosti Philips.

Ed Problémy se zobrazenim

Obraz neni vystredén

* Upravte polohu obrazu pomoci funkce
, Auto” v hlavnich ovlddacich prvcich OSD.

* Upravte polohu obrazu pomoci poloZzek
Phase/Clock (Faze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavn{
ovlddaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz se chvéje na obrazovce

» Zkontrolujte, zda je kabel signdlu radné a
bezpelné€ pripojen ke grafické desce nebo k
pocitaci.

Dochazi ke svislému blikani

* Upravte polohu obrazu pomoci funkce
, Auto” v hlavnich ovlddacich prvcich OSD.
*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platna
pouze v rezimu VGA.

Dochazi k vodorovnému blikani

=
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Upravte polohu obrazu pomocf funkce
,Auto™ v hlavnich ovlddacich prvcich OSD.
Omezte svislé pruhy pomocf poloZek
Phase/Clock (Féze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis
tmavy

Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,,vypaleni* nebo ,,zobrazeni duchu*
zUstane po vypnuti napajeni.

Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni** obrazovky, rovnéz
znamé jako ,,dosvit"* nebo ,,zobrazeni
duchl®. ,Vypdleni*, , dosvit" nebo
,,zobrazeni duchd" je dobre znamy jev

u technologie panell LCD. V mnoha
pripadech ,vypdleni*, ,,dosvit" nebo
,zobrazen{ ducht* postupné zmizi po
urcité dob€ mimo provoz.

Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

Bude-li na vaSem monitoru LCD zobrazen
nemeénicl se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.
Vazné priznaky ,vypaleni, ,,dosvitu" nebo
,,zobrazeni duchd" nezmizf a nelze je
opravit. Na vySe uvedené poskozeni se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo
rozmazany.

Nastavte rozliSeni zobrazeni pocitace
na stejny rezim, v jakém se nachdzf
doporucené nativni rozlideni obrazovky
monitoru.

Na obrazovce se objevuji zelené, cervené,
modré, tmavé a bilé tecky

Zbyvajici body jsou normalnf vlastnostf
tekutych krystall pouzivanych soucasnou
technologii. Dalsi podrobnosti viz pravidla
pro obrazové body.
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Svétlo indikatoru ,,napajeni* je prilis silné a

rusi

* Muzete nastavit intenzitu svétla indikdtoru
,napajeni* v ¢asti Power LED (Indikdtor
LED napdjeni) v ¢asti Setup (Nastaven)
v OSD Main Controls (Hlavni ovlddaci
prvky nabidky OSD).

Potrebujete-li dalsi pomoc, viz seznam
Informaclnf strediska pro zdkazniky a kontaktujte
zastupce sluzeb pro zdkazniky spolecnosti
Philips.

8.2 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluji svij monitor, co
mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa
nelze zobrazit)?

Doporucené rozliseni pro tento

monitor: 1920 x 1080 pri 60 Hz.

»  Odpojte vSechny kabely, potom pfipojte
pocitac k monitoru, ktery jste pouzili predtim.

* V Start Menu (nabidce Start) operacniho
systému Windows vyberte Settings/Control
Panel (Nastaveni/Ovlddaci panely). V okné
Control Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazen). Na panelu Display
Control (Zobrazeni — vlastnosti) vyberte kartu
,Settings™ (Nastaveni). Na karté nastaven(

v poli oznaceném ,,desktop area" (pracovnf
plocha) presurite posuvnik na 1920 x 1080
obrazovych bodu.

* Klepnéte na ,,Advanced Properties” (Upresnit),
nastavte polozku Refresh Rate (Obnovovaci
frekvence) na 60 Hz a potom klepnéte na OK.

* Restartujte pocitac a zopakovdnim kroku 2 a
3 ovérte, zda je pocitac nastaven na 1920 x
1080 pri 60 Hz.

*  Vypnéte pocitac, odpojte stary monitor a
znovu pripojte monitor LCD Philips.

* Zapnéte monitor a potom zapnéte pocitac.

Odpovéd:

OTAZKA 2: Jaka je doporucena obnovovaci
frekvence monitoru LCD?
Doporucend obnovovaci frekvence
u monitort LCD je 60 Hz. V pripadé

jakéhokoli ruseni na obrazovce ji

Odpovéd:



OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpovéd:

OTAZKA 5:

Odpovéd:

OTAZKA é:

Odpovéd:

OTAZKA 7:

Odpovéd:

mUZete nastavit na 75 Hz a uvidite,
zda ruseni zmizi.

Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat
ovladace (.inf a .icm)?

Jednd se o soubory ovladace
monitoru. Pri instalaci ovladacd
postupujte podle pokynt v
uzivatelské prirucce. Pri prvnf instalaci
bude pocitac pravdépodobné
pozadovat ovladace monitoru
(soubory .inf a .icm) nebo disk s
ovladaci. Postupujte podle pokynt a
vloZte (doprovodny disk CD-ROM),
ktery je soudasti této sady. Ovladace
monitoru (soubory .inf a .icm)
budou nainstalovadny automaticky.

Jak mam upravit rozliseni?
Dostupna rozlisenf urcuje grafickd
karta/ovladac grafiky a monitor.
PoZadované rozliseni mizete vybrat
v ¢dsti Control Panel (Ovlddact
panely) systému Windows® v &sti
,Display properties” (Zobrazenf -
vlastnosti).

Co kdyz se béhem nastaveni
monitoru ztratim prostrednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset” (Obnovit)
obnovte viechna pdvodni nastaveni
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmémym uderdim
a chranit jej pred ostrymi nebo
tupymi prredméty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu Zadny tlak ani silu. Mohlo by
to negativné ovlivnit vase zaruc¢nf
podminky.

Jak Ize Cistit povrch monitoru
LCD?
Pro bézné cisténi pouzijte Cisty
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a mekky hadrik. Pro dikladné
Cisténi pouzijte izopropyl
alkohol. NepouZivejte 7zadna jind
rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

OTAZKA 8: Lze ménit nastaveni barev
monitoru?

Odpovéd:  Ano, nastaveni barev mizete zménit
prostrednictvim nabidky OSD podle
nasledujicich krokd:

»  Stisknutim tlacitka ,,OK" zobrazte nabidku

OSD.

«  Stisknutim tlacitka ,,Down" (Sipka dolt)
vyberte volbu ,,Color” (Barva) a stisknutim
tlacftka ,,OK" priejdéte na nastaveni barev. K
dispozici jsou tfi nastaven( (viz nize).

1. Color Temperature (Teplota barev):

k dispozici je dvou nastaveni: 6500K a
9300K. Pri nastaven( v rozsahu 6500K
vypadaji barvy na panelu ,teplé s
Cervenobilym barevnym tonem”, zatimco
pri nastaven( teploty 9300K vypadajf
barvy na panelu ,,studené s modrobilym
barevnym ténem®.

2. sRGB: standard pro zajistén{ spravné
prenosu barev mezi rdznymi zarizenimi
(napt. digitdlni fotoapardty, monitory,
tiskdrny, skenery atd.)

3. User Define (UZivatelské): uzivatel si mdze
zvolit vlastni nastaveni barev upravenim
Cervené, zelené a modreé slozky.

& Poznimka:

Mérenf svétla barvy, které vyzaruje predmét prf
zahrivani. Toto mérenf je vyjadreno v absolutnim
meritku (stupné Kelvina). Nizsi teploty Kelvina,
napriklad 2004K, jsou Cervené; vyssi teploty, jako
napriklad 9300K, jsou modré. Neutrdni teplota je
bild pri 6504K.

OTAZKA 9:  Lze pFipojit tento monitor LCD
k libovolnému pocitaci, pracovni
stanici nebo pocitaci Mac!?

Odpovéd: Ano.Viechny monitory LCD
Philips jsou pIné kompatibilni se
standardnimi pocitadi, pocitaci
Mac a pracovnimi stanicemi. Pro
pripojeni monitoru k systému
Mac mUZe byt zapotrebi kabelovy



OTAZKA 10:

Odpovéd:

OTAZKA 11:

Odpovéd:

) Vystraha

adaptér. Dalsl informace vdm
poskytne nejblizsi obchodnf
zdstupce Philips.

Jsou monitory Philips LCD
vybaveny technologii Plug-and-
Play?

Ano, tyto monitory jsou
kompatibilni s technologif Plug-
and-Play v operacnim systému
Windows 7/Windows 8,Vista, XR
NT, Mac OSX a Linux.

Co znamena Ipéni obrazu,
vypaleni obrazu, dosvit nebo
,duch® v souvislosti s panely
LCD?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu mUze zpUsobit
,vypaleni"* obrazovky, rovnéz
znamé jako ,,dosvit" nebo
,zobrazeni duch(”. ,Vypaleni,
,dosvit" nebo ,,zobrazeni duch(”
je dobre zndmy jev u technologie
paneld LCD.V mnoha pfipadech
,vypalenf, ,dosvit" nebo
,,zobrazeni duchd" postupné zmizf
po urcité dobé mimo provoz.
Pred ponechdnim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vasem monitoru LCD
zobrazen nemeénici se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Selhdnf aktivace sporice obrazovky nebo aplikace
pro pravidelné aktualizovdni obrazovky mize mit
za nasledek vazné priznaky ,vypaleni*, ,,dosvitu"

nebo ,,zdvojeného dosvitu”, které nezmizf a

nelze je opravit. Na vyse uvedené poskozeni se

nevztahuje zdruka.

OTAZKA 12: Pro¢ se na displeji nezobrazuje

Odpovéd:

ostry text a pro¢ maji
zobrazené znaky zubaté okraje?
V4s monitor nejlépe pracuje pri
svém nativnim rozlieni 1920

x 1080 pri 60 Hz. PouZivejte
toto rozlideni pro dosazenf
optimalniho zobrazent.
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